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1. Product Evaluation Kit Overview

This Product Evaluation Kit will help you evaluate all features of Crystal Reports® 2008, and will
highlight some exciting new functionality.

There are three sections in this guide:
e Crystal Reports 2008 Product Overview
¢ New Features Summary
e Step-by-Step Test Drive of New Features

For more information or additional support materials, please visit:
http://www .businessobjects.com/product/catalog/crystalreports/




2. Crystal Reports Product Overview

Transforming data into actionable information.

Crystal Reports is an intuitive reporting solution that helps customers create flexible, feature-rich,
dependable reports, and tightly integrate them into both thick and thin client applications.

The Crystal Reports solution consists of:

e Powerful report designer: Report authors benefit from a complete set of layout and
design controls to create highly formatted, interactive, and professional looking reports.
Use the standalone designer, or the design tool integrated within Visual Studio without
leaving the development environment.

¢ Flexible application development: Developers can leverage cross-platform support for
Java and .NET development technologies. HTML is generated directly by Crystal
Reports, allowing developers to focus on application business logic, rather than tedious,
time-intensive hand coding. Separation of application development and report design
tasks allow developers to focus on application development, while the report authors can
focus on report design.

¢ Report management and delivery: Reports are easily previewed in HTML and published
to the web, for better business decisions at all levels of the organization. They can also be
exported and repurposed to the electronic formats used by most end users such as PDF,
Excel, and RTF. IT can centralize the management of operational reporting while
distributing the report authoring function to the lines of business.
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3. What’s New in This Release

Crystal Reports 2008 provides advanced functionality to help reduce report proliferation and
maintenance —increasing visualization flexibility and saving time with highly productive design
features such as:

¢ Advanced information visualization capability
¢ Improved end user viewing experience

¢ Enhanced report designer productivity

e New flexible deployment options

¢ Flexible application integration

¢ A more streamlined and flexible report designer

Advanced Information Visualization with Flash, Flex and Xcelsius!

Adobe Flash integration: A wide variety of flexible data presentation options are now available
through Flash. Flash (SWF) files can be integrated into your report and report data can be shared
with SWF via Flashvars for compelling, interactive, and information-rich reports. The SWF files
can be embedded in the report or linked via a website.

Xcelsius integration: Import Xcelsius-generated SWF files into your report and benefit from
improved design-time integration and stunning visualizations. Enhance your reports with what-
if analysis models that enable users to make important decisions dynamically, without leaving
the report file.

Adobe Flex integration: Integrate your reports with operational workflows by embedding
Adobe Flex (SWF) applications into your reports. Using Adobe Flex Builder you can create any
business-user Ul to access report data and integrate with external web services. Data in your
report can be passed to the Flex application via Flashvars, making it easy to create a flexible Ul
even when you don’t have access to your data via web services. The Flex applications can do
tasks like database write-back — invoking operational workflows directly within Crystal Reports.

Improved End-User Report Viewing Experience

Interactive report viewing: On-report sorting, filtering, and report reformatting with the NET
Winform, Java DHTML, and .NET Webform viewers allows users to explore information
interactively without re-querying the database. New optional parameters provide for complex
user-driven filtering scenarios. Users can answer more business questions with fewer, more
flexible reports — significantly reducing Developer and IT support dependency.

Parameter panel: The report designer and the NET Winform, Java DHTML, and .NET Webform
viewers have a parameter panel so that parameter values can be set without refreshing data.

! Flash features are available for viewing in the .NET, Winform and Java DHTML viewers only
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Parameters used are displayed on the panel so that report consumers can easily see them, make
changes, and have the new values applied directly to the saved data.

Flexible pagination: Report designers can customize page size and easily control page breaking
after N records/groups. A single report can combine portrait and landscape oriented pages and
the white space at the end of groups can be removed by compressing the page footers. Online
report consumption is improved because reports are easier to read.

Enhanced Report Designer Productivity

Powerful crosstabs: Summary, variance, and any other customer calculations can be inserted
into a crosstab row or a column — especially useful for reports that benefit from a table structure,
such as financial reports. The crosstab table structure makes reports much faster to build and
maintain. This feature also provides powerful benefits to crosstab-based charts since custom
formulas in the crosstab can be visualized within the charts.

Built-in barcode support: Generate barcodes with only a few clicks of the mouse by using the
new “turn to barcode” function in the context menu. Easily convert fields to Code39 barcodes
without any coding or extra steps. Additional barcode fonts are available from third-party
vendors.

Enhanced designer features: Report designer will be more productive with features like global
formula search, duplicate formula, duplicate running total, auto complete field names, and the
Find in Field Explorer feature.

Hyperlinking wizard? Report designers will save time by automatically creating the Crystal
Reports formula required to invoke a BusinessObjects Enterprise OpenDocument hyperlink.

New Flexible Deployment Options

Save reports directly to crystalreports.com: Expand your deployment options with on-demand
reporting capabilities when you open and save reports directly to crystalreports.com. This new
integration allows you to manage and share your reports securely without dependency on IT.

Improved XML exporting: Render reports in almost any format and enjoy faster and easier
integration with your industry-specific business processes — without any custom coding. The
XSLT transformations are embedded into the report file and will be triggered by users from
within the viewer when exporting to XML. This provides a powerful, flexible hook for
transforming Crystal Reports data and integrating it into other applications.

Advanced report publishing? Also known as report bursting, advanced report publishing is a
platform for the mass distribution of personalized content. Multiple reports can be created based
on different data sources, combined into one desired file format (such as PDF), loaded with
personalized content, and then sent to a dynamic list of recipients — with a single action. The
content can be archived, printed, or emailed in separate actions, or simultaneously. This makes
scheduling much faster and easier, with the ability to conduct cost effective one-on-one
marketing campaigns and other personalized high-volume reporting.

? Available only with a BusinessObjects Enterprise XI Release 3 server environment

Crystal Reports 2008—Reviewers Guide Page 6 of 26



Improved Report Designer

Single edition: Crystal Reports 2008 comes in a single edition that is the feature equivalent of the
old Developer Edition. This single offering provides customers with quick access to the features
they need to meet any application and user requirement. Report samples and developer
documentation are now a free, optional download.

Multilingual reporting: Choose the working language you prefer by simply selecting the
language packs you wish to use during product installation. Then switch the report designer Ul
to use any of the installed language packs. The report content locale can also be explicitly set for
each report file. This setting controls sorting, grouping and formatting that matches the local
language customs and conventions.

Reduced install footprint: The download size has been reduced to 250MB to provide fast access
via the download site. The runtime files included in developer applications are also significantly
smaller.

Flexible Application Integration

Integrated salesforce.com driver: The salesforce.com driver included with Crystal Reports 2008
allows for easy access to complete customer data — turning it into actionable business
information. Reports that use a salesforce.com driver will refresh when deployed to
crystalreports.com.

Enhanced web services data driver: Integration with various web services can be difficult and
complex due to a wide variety of implementation types. The new data driver offers additional
web access to web services by providing support for RPC encoding of SOAP messages, SSL-
secured web servers, as well as a working compatibility with the WS-Security standard. It adapts
to custom logon requirements such as email addresses or user/password.

NET report modification SDK: The Report Application Server SDK is now available for users of
CR.NET API without the use of a RAS server. Report modification such as changing / adding /
removing database providers, adding / removing / creating report objects, parameters, formulas,
and sections can be achieved by accessing the RAS SDK through the CR .NET SDK.

What's Different in Crystal Reports 2008

In an effort to improve the Crystal Reports experience, we’ve made some changes to certain
components of Crystal Reports 2008:

Reports samples and sample database: To reduce download time, report samples and the
Xtreme sample database are now accessed through separate downloads on the Start Page of
Crystal Reports 2008.

.NET developer SDK documentation, merge modules, and MSI files: .NET developer
documentation, merge modules, and MSI files are now accessed through separate downloads on
the Start Page of Crystal Reports 2008.

Report developer component (RDC): The RDC is unsupported in Crystal Reports 2008.
Developers wishing to use Crystal Reports in a COM application should use Crystal Reports XI
Release 2. The ActiveX viewer remains a fully supported component of Crystal Reports 2008.
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Advanced DHTML viewers: The Advanced DHTML viewers have been removed from Crystal
Reports 2008. The improvements to the DHTML viewers make these additional viewers
unnecessary.

Java reporting component (JRC) availability and Java SDK documentation: Java developers
now receive the JRC and Java SDK documentation through the free Crystal Reports for Eclipse
download. This product will be updated on a separate schedule from Crystal Reports. Visit the
start page in Crystal Reports 2008 for more information on updates to Crystal Reports for Eclipse.

@
Business Objects
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4. New Features Test Drive

We recommend you unzip the Reviewers Guide Files.zip. Access to the reports and additional
files contained will be required throughout the following exercises.

4.1 Flash Integration

With Flash integration, report authors can embed any Shockwave Flash file (SWF) into an RPT
file, to insert Xcelsius charts and widgets into Crystal Reports. This includes the ability to pass
data from Crystal Reports into the Xcelsius SWF. Now report authors can extract and massage
data before pushing it into Xcelsius visualizations.

Xcelsius version 5 and higher will tag ‘Sharepoint parameters’ used in Xcelsius SWFs with
specific metadata that will make data binding between Crystal Reports and Xcelsius simple.

Data binding to other SWFs is also supported, but report authors should have a deep
understanding of the target SWF’s parameters and Crystal Reports’ formula language to leverage
this functionality. A how-to guide on integrating Xcelsius 4.5 visualizations into Crystal Reports
2008 can be found at:

http://www.businessobjects.com/pdf/product/catalog/crystalreports/WP3120 A CX Visual CR08.pdf

Adding a Simple Chart

1. Open the Flash Integration.rpt report provided with this guide.
. Choose Flash from the Insert Menu (accessible from the Design or Preview tab).
3. Browse to Simple Pie Chart.swf provided with this guide. Select OK and place the SWF
in your report header.
4. Right-click on the SWF and select Flash Data Expert.

You should now be in the Flash Data Binding Expert where you can map Crystal Reports
fields or formulae to the SWF parameters as follows:

5. Click and drag the {Customer.Country} field from the Available Fields to the Row Label
area :



Flash Data Binding Expert
“eelsius Data | Flash vars
Preview
Available Figlds: i
= 2 Rreport Fields | Title
i = HEaraot [Clstomer x0020. Guiery.Country T is_} Lt
== dataroot/Customer_x0020_Cuery.Region
<= _datarnot/Customer_x0020_Cuary.Last_x0020_Year_x0027_s_xD020_Gales =
= @ http:fiant productbusinessohjects.comfxtreme/customer, xml http:ffiant. product busiies o i
em
= [ :Iita:outﬁt.lsutorrﬂvirq_xu?‘zo_query :"l M Ttem 2
< 1 | [] = %:2 3
Item 5
T e o Fion £z
A
Insert Row Label Insert Data Yalue
Description
)
)
* Yalues are temparary and may not reflect values on the report
ok J [ cancel |[ Heb

6. Click and drag the {Customer.Last Year Sales} field from the Available Fields to the Data
Values area.

7. Select OK, then go to the Preview tab and note the resulting SWF with data populated
from the report.

You have now created a simple Xcelsius chart using data pushed from the RPT. The next exercise
will show you how to edit the display of the information within the chart.

Changing Display Information in a Chart
The data being sent is displayed in alphabetical order. To sort by top sales by country:
1. Right-click on the Xcelsius chart and select Flash Data Expert.
NOTE: If you still have mouse focus inside the SWF you will need to click on the canvas
first to access this menu item.

2. Click the Row Label area and select Group Sorting to access the Top N options. You will
use these options to limit the data being passed to this chart (see screenshot below).
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Flash Data Binding Expert
relsius Data | Flash vars S
puvailable Fids: T
= 2 Report Fields i&\\ Title
== dataroot/Customer_x0020_Query, Country |5] S ubtit
== dataroot/Customer_x00Z0_Guery. Region
=1 datarook{Customer_x0020_Query. Last_x0020_Year_x0027 _s_x0020_Sales W Argentina
= [ htkp:fiant.product businessobjects.com/xtreme/cuskomer xml hkbp: fiant . product, busines M Aruba
= [ datarook/Customer_x0020_Query = W Australia
| =1 ks OO0 TO . ; ‘i.vl B Austria
<] I | [E3)] Bahamas
Bangladesh
K e+ 4 Options ] [ Group Sorting ] Barbados
z . M Belgium
||
Argentina
Aruba =
Australia
Austria 1
Eahamas
Bangladesh Description
Earbados
Belgium
1. Click to highlight
* Yalugs are kemporary and may not refleck values on the report 2. Choose Group Sorting
| o
[ QK ] [ Cancel ] [ Help

3. Select the options to only return the Top 8 Countries based on Last Year’s Sales from the
Top N / Group Sort expert
NOTE: the value here is exposed as a formula, providing an easy way to control it by an
Interactive Parameter at view time.

4. Select OK.

5. Go to the Preview tab of Crystal Reports to see your changes.

Now add a title and subtitle to the chart:

Select the FlashVars tab in the Data Binding Expert.

Add a string value for both the Title and Subtitle parameters.
Select OK.

Go to the Preview tab of Crystal Reports to see your changes.

Ll e

Once complete, your report should look like Flash Integration Completed.rpt

4.2 Sort Controls

Sort Controls allow your report users to sort all parameters in a report without a database
connection.

In this exercise your finance team requires additional analytical capabilities for their Purchase
Order Report. They would like to be able to re-sort the report by any of the columns. With
Crystal Reports 2008 you can modify the Purchase Order Report so all columns have
corresponding Sort Controls as shown below.
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L | B f - f 3 o 4 f 5 f - f 7 -
Purchase Order Report
Purchase = Date = Quantity =  Unit Price 5  Product 3 Product = Product Hame =
Order # Class Category

1 01/22/2003 220 $6.53 ACCESSONY Gloves Active Cutdoors Crochet Glove
2 01,22/2003 450 $6.53 ACCESSONY Glaves Active Outdoars Crochet Glove
3 01s22/2003 325 ACCESSORY Gloves Active Cutdoors Crochet Glove
4 0172272003 265 ACCESEOFY Gloves Active Outdoars Crochet Glove
5 0172212003 367 $6.53 Active Outdoors Crachet Glove
6 01r22/2003 440 §7.43 ACCESTOrY Gloves Active Outdoors Lycra Glove
7 012272003 358 F7.43 ACCESsory Gloves Active Outdoors Lycra Glove
i 01s22/2003 266 §7.43 ACCESSONY Gloves Active Outdoors Lycra Glove
a 01r22/2003 750 §7.43 ACCESSOrY Glaves Active Outdoars Lycra Glove

10 0142202003 112 5743 ACoEssory 3l Active Cuutdoors | scra Gl

" 0172272003 686 §7.43 Accessory

12 01/22/2003 T3 §16.66 ACCESSONY

13 0172272003 g0 §16.86 ACcessory .

14 01/22/2003 55 $18.86  Accessary Sort controls active

15 0142212003 163 $16.86 Accessory for all report columns

18 01F22/2003 200 §15.86 ACCESsOry

17 0142212003 168 §16.86 ACCESSONY

18 01,22/2003 &8 §24.26 ACCESEOFY

19 0142212003 125 $24.26 ACoEssory Helmets Trium ph Wertigo Helm et

20 01r22/2003 220 §24.26 Acceszory Helmets Trium ph Yertigo Helm et

21 01F22/2003 150 F24.26 ACCESIOrY Helmets Trium ph Yertigo Helm et

22 01r22/2003 a2 §24 26 ACCESTOrY Helmets Trium ph Yertigo Helm et

23 01F22/2003 187 $24.26 ACCESEOFY Helmets Trium ph Yertigo Helm et

24 01r22/2003 766 §24 26 ACCESSONY Helmets Trium ph Yertigo Helm et

25 012272003 224 §24.26 ACcessory Helmets Trium ph Yertigo Helm et

26 0142202003 E3 $24.26 ACoEssory Helmets Trium ph Wertigo Helm et

27 01,22/2003 110 $2.03 ACcessory Locks Guardian Chain Lock

4

o7

Ll limm WA o)

Define Sorts

1. Open the Purchase Order Report..rpt report.

Define the appropriate sorts in the report before configuring Sort Controls. Choose
Report then Record Sort Expert from the menu.
3. Ensure the following are defined as sorts in the report:

{@purchaseOrderNumber}
{Purchase Order.Date}
{Purchase Detail Quantity}

e {Purchase Detail.Unit Price}
{Product.Product Class}
{Product Type.Product Type Name}
{Product.Product Name}

Crystal Reports 2008—Reviewers Guide
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“ Record Sort Expert

Available Fields: Sort Fields: + +
= & Feport Fields

= 4, - [@purchazedrdertumber

?

> ]
= Purchase Order.Purche
= Purchaze Order.Date | _ ﬁ
== Purchase Detail Quanti
= Purchase Detail. Unit Py /
= Product Type.Product A
== Product. Product Mame
== Product Product Class
Fx purchazeOrde™Murmber Sort Direction;
= [ #treme Sample Database 1[v] (%) Azcending
[{ ] m | [ }] () Descending

[ ] H Cancel ][ Help

Bind Sort Controls
You are now ready to bind text objects to the sorts as Sort Controls.
1. Right click on each text object and select Bind Sort Control.

2. Choose the sort that the object will control to bind all text objects (column headings) on
the report to the record sorts you created.
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Purchase Order Report
/ . B .
Purchaze ate Quantity unit Price Product Product Product H:
( order # claiz Ccategory
[
il 022/2003 220 F06.53 Accessory Gloves Active Qut
2 0q22/2003 450 F6.53 Acoessorny Glaves Active Out
8 0 A0 i Fif A L 5l Active Outy
. . o7 % Sort Control Sctiverduh
right click on text object : _ _ WA
Bind Sort Control J .T.he Satt Contral wil change the Faollawing sort el
- < d | = Mat Inkeractive > Active Out
9 g | = A - @purchaseOrdertumber Active Out
10 0 | == 4 - Purchase Order.Date Active Outr
11 0 | == 4 - Purchase Dekail, Quantity Active Outs
12 g | == 4 - Purchase Detail. Unit Price Triumph P
12 9 | e= 4 - Product Type.Product Type Name VHinoml (P
5 O | == & - Product. Product Mame ALE ki
ik 9 | = & - Product. Product Class idmphikl
i 9 = A - Purchase Order,Purchase Crder # Tr!u mphiE
g5 [ Triumph P
18 0 Triumph W
19 [ Triumph W
20 L Triumph W
21 0 [ i l [ Gencs Triumph W
Triumph W
select the sort to control 01/22/2003 187 §249.28 Aocessory Helm et Triumsh A
. 04:22/2003 ﬂ?ﬁﬁ 52426 Aocessory Helmets Triumph W
E;Z;;‘Z’EV 224 F24.26 Accessory Helmets Triumph W
2003 6o 24,26 Accessory Helmets Triumph W
012242003 110 $2.03 Accessorny Locks Fuardian C

28 OAs220200%3 22 F7.88 Accessong Lacks

Your finished report should look like Purchase Order Report Completed.rpt

Other Ideas

Guardian"

e Experiment with the on-canvas sort widgets to see how they manipulate the saved data

in the report

* Try adding a Sort Control and binding it to a sort using the Insert 2 Sort Control menu

option
e Experiment with binding different record sorts to Sort Controls:
o Database Fields
o Formula Fields
o SQL Expression Fields

¢ Add groups and group summaries to your report and bind Sort Controls to them

4.3 Interactive Parameters

In this exercise you'll modify the Order History Report so that two record filter types (product
category and order date range) are available in the new parameter panel for selection by report

consumers.
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Add a Report Parameter

1. Open the Order History Report.rpt report.

Create a new parameter called Product Category - From the View menu, select Field

Explorer, right-click on Parameter Fields in the Field Explorer and choose New.
3. Set the parameter properties to match the screen below.

Create Mew Parameter

Mame:

Tvpe: List of Yalues:

| Product Cateqgaory

| |string || | static ™

Walue Field Description Field

|'E' Product Type Mame Ill | (Mone)

B % 4 & Acions -

Walue Descripkion
Walue
Competition
Gloves
Helmets
Hybrid
Kids
Locks
Mauntain

Saddles
Click here to add item

Value Options:

Opkion Setting
Show on (Wiewer) Panel Editable
Prompk Text

Prompt With Descripkion Only
Opkional Prompk

Ciefault Value

Allow custom walues
Allow multiple values
Allow discreke values
Allow range values

Enter Product Category:
False
False

True
False
True
False

|

4. Repeat step 3 with a new parameter called Order Date Range.
5. Set Order Date Range’s parameters to match the screen below.
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Create Mew Parameter m

€ Create anew parameter and list of values.

Mame: Trpe: List of Yalues:
Order Date Range |Date M |Static M
Walue Field Description Field
| {Mane) M (Mone)
@ W+ ¥ Adions -
Walue Description

Click here o add item

Walue Options:

Opkion Setting hid
Show on (Wiewer) Panel Editable

Prompk Text Enter Order Date Fange:

Prompt With Descripkion Only False

Optional Prompt False

Default Value

Allow custom walues True M

Gk ] ’ Cancel l ’ Help l

Define Saved Data Selection Formula

To add a report filter go to Report-> Selection Formula-> Saved Data and in the Formula Editor
enter {Product Type.Product Type Name} in {?Product Category} and {Orders.Order Date} in
{?Order Date Range}

Other Ideas

e Create a report parameter to conditionally filter orders greater than $1000.

* Add a dynamic grouping by using a new report parameter and formula field to enable
the report consumer to change the grouping of a report dynamically. For example: Group
by Order ID, or Group by Product Category.

4.4 Crosstab Improvements
In this task your finance department wants to enhance their current set of financial reports. One
of the reports groups data by Account Type, Account Heading, Account name, and gives

monthly actual and budget data, as well as a variance of the two.

Your job is to enhance this report to display actual, budget, and variance information for multiple
months. The columns should be dynamic and the end user should be able to select a date range
to determine how many columns to display.

Crystal Reports 2008—Reviewers Guide Page 16 of 26




This advanced use case will show you how to modify the existing cross tab to simplify the report
format. You'll then modify the revenue section of this report to incorporate calculations within
across-tab.

Simplify the Report - Remove Extra Totals
Open the Variance Cross Tab.rpt report in the Crystal Reports Designer.
Right-click on the report and select the Cross-Tab Expert. Change the settings on the Customize
Style tab to remove extra totals and to change formatting options to improve the look and feel of
this financial report:

Check on Indent Row Labels and set it to 0.30.

1.
2. Uncheck Show Grid Lines available from Format Grid Lines button.
3. Select OK to save these changes.

Cross-Tab Expert
Cross-Tah | Style | Customize Style
(Dptional) Customize the grid's skyle . o
Select a row or column name to choose its background color, Modify other options as desired, ngh"ght and
check
Calurnns:
Grand Tokal _ /
| — - /
Ears Command, Amount_type | /

Grand Takal T Summarized Fields:

Command. Account Type & vertical []show Labels
Command. Account Heading Mame w (") Horizontal
Group Cptions

Suppress subkotal

ias For Formulas: Command.Date

[Jsuppress Label Backgraund Calar: - Custom v..
e prs L Check (suppress)
Repeat Row Labels Suppress Emnply Rows
[Jind bel U e O /
Indent Row Labels /
Keep Columns Together [] 5uppress Empty Columns
[#] alumn Totals on Top Suppress Row Grand Totals !_;‘
7 4 e [¥]Row Tatals on Left Suppress Column Grand Totals “'-—I-—-' -
[ Shaws Cell Margins [ Format Grid Lines ]
[ OK 1 [ Cancel ] [ Help ]

Add and Modify a Calculated Member (Single Non-Recurring Row)

1. Right click on Sales Revenue and choose Calculated Member -> Revenue->Sales
Revenue.

2. Right click on Sales Revenue again and choose Difference of Revenue-> Sales Revenue
- Sales Returns and Revenue -> Sales Revenue.

Update the calculated member to display the correct calculation and show the correct header
name.

3. Right click on Difference and select Calculated Member -> Edit Header Formula.
4. Change the formula from Difference to Net Sales.
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5. Right click on one of the summaries in the Net Sales row and select
Calculated Member - Edit Calculation Formula. The formula that creates this Calculated
Member will be displayed:

GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Sales Returns"),
CurrentColumnindex, CurrentSummaryIndex) -
GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Sales Returns"),
CurrentColumnIndex, CurrentSummarylndex)

6. Change the formula to:

GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Bike Sales -
Competition"), CurrentColumnIndex, CurrentSummaryIndex)

+ GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Bike Sales - Hybrid"),
CurrentColumnIndex, CurrentSummarylndex)

+ GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Bike Sales - Kids"),
CurrentColumnIndex, CurrentSummaryIndex)

+ GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Bike Sales -
Mountain"), CurrentColumnIndex, CurrentSummaryIndex)

+ GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Sales Gloves"),
CurrentColumnIndex, CurrentSummarylndex)

+ GridValue At(GetRowPathIndexOf("Revenue", "Sales Revenue", "Sales Helmets"),
CurrentColumnIndex, CurrentSummaryIndex)

+ GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Sales Locks"),
CurrentColumnIndex, CurrentSummarylndex)

- GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Sales Returns"),
CurrentColumnIndex, CurrentSummaryIndex)

+ GridValueAt(GetRowPathIndexOf("Revenue", "Sales Revenue", "Sales Saddles"),
CurrentColumnIndex, CurrentSummarylndex)

7. Select Save and Close from the menu of the Formula Workshop dialog box.

The final Calculated Member (Net Sales) is now a complex summary where all Sales items are
added and Sales Returns are subtracted:
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Stark Page

¥ariance Cross Tab.rpt <

Design | Preview =

1Sroups
Yariance Cross Tabor

< >
-Ej Groups

(21 Parameters

42 Find

FHb

Calculated member added to report

A.
1/1/2005 2/1/2005
Actuals Budget Actuals Budget
Revenue $267,910.03 $240,882.44 $321,321.77 $163,8549.
Sales Revenue $267,910.03 $2460,882. 44 $321,321.77 $163,289.
Bike Sales - Col $187,302.75 $193160.46 $254,504.70 $131,861.
Blk,%é;lﬁgngyli $15,764 .61 $1,387.85 $23,611.07 $3a7.
Bike Sales - Kid $3,547.649 $4,385.28 $4,381.00 $4,061.
886.24 $42,778.82 $31,381.18 $20,317.
T EEEE. 65637 $620.78 £20.
Sales Helmets $3506.74 \\\$4,936.BD §2381.74 §3.845
Sales Locks $741.26 $N93.32 F429.05 617,
Sales Returns §14,336.10 51 ,1‘13‘3.?9 $3,421.75 §3,027.
Sales Saddles $1,088.66 §1 ,DEEQQE $490.50 76
Met Sales $239,237.83 $248 654.86 $314,478.27 §1467, 834,
Expense §178,82014 §137,720.33 $204,853.00 §235,234.
Cost of Goods ¢ $116,315.53 $92,751.20 $144,041.41 $203,895. 1,

Add a Calculated Member (Recurring Column)

>

Currently the data returned from the query is only for Actuals and Budget information. The
financial report requires a Variance column (the difference between Actual and Budget).

Accomplish this using the same right click context menus as the first example.

1. Right click on Actuals for January and set your first value to be Calculated Member >
Select CDateTime (2005,01,01,00,00,00) = Actuals.
2. Right click on Budget for January and choose Calculated Member > Difference of
CDateTime (2005,01,01,00,00,00) = Budget and CDateTime (2005,01,01,00,00,00) ->

Actuals.

You've just created a non-recurring Calculated Member as a column.

3. Rename the column to “Variance” by right clicking on the Difference headed and
selecting Calculated Member - Edit Header Formula. Change “Difference” to
“Variance” in the formula area.

4. Make the Calculated Member recurring by right clicking on the Difference header and
selecting Calculated Member > Edit Insertion Formula.
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5. Change the existing formula — right click on one of the summaries in the Difference

column and select Calculated Member -> Edit Calculation Formula and change the
formula to read:

GetColumnGrouplndexOf(CurrentColumnIndex) =2 AND
GridRowColumnValue("Command.Amount_type") = "Budget"

StartPage - WVariance Cross Tab.rpt

Desian  Preview X

Groups T
Variance Cross Tabs ~ FHa

FHb !
/172005 21112005 || 21172008 3112
Actuals Budget Variance Actuals Budget ‘ Variance Actu
|
Revenue §267,910.03 $250,882.44 517027 59 §321,321.77 §163,889.18 | | §157,432.59
¥ I
= R Sales Revenue §267,810.03 $250,882.44 §17,027 50 $321,321.77 §163,889.18 ‘ $157,432.59
] . i = (§5,857.71) $254,504.70 §131 56007 | | $122,943.63
T srous Recurring "Variance" column now appears after == !
I
R each "Budget" column i §14,376.76 §23,611.07 $357.21 : $23,253.36
: —_— Bine saies - nu PR w000 (837.59) §4,381.00 4,061 47 | | $319.53
e I
A Bike Sales - Mo/ $40,356.24 §432,775.82 ($1,822.58) $31,381.18 $20,317.15 | ¢ §11,064.03
I

Modify the calculation formula to be recurring by editing the calculation formula to
match the one below, which makes the calculation formula relative; rather than absolute.

GridValueAt(CurrentRowIndex, CurrentColumnIndex-2, CurrentSummaryIndex)-
GridValueAt(CurrentRowIndex, CurrentColumnIndex-1, CurrentSummaryIndex)

Select Save and Close from the menu of the Formula Workshop dialog box.

Other Ideas

Create a blank ‘spacer’ row beneath Net Sales, before Expense.
Create a Calculated Member for Total Operating Expenses, which is a subtotal of all
Expense line items (it’s okay to use subtotals).
Suppress summaries for the following header rows:
o Revenue
Sales Revenue
Expense
Cost of Goods Sold
General & Administrative Expenses

o O O O

o Payroll Expenses
Create a blank ‘spacer’ row beneath Total Operating Expenses.
Create a Calculated Member final line item for Net Income, which is the Net Sales minus
Total Operating Expenses.

The finished report should look like Variance Cross Tab Completed.rpt
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4.5 Barcodes

In this task you’ll add a barcode field for the tracking fields Order Number and Postal Code. The
desired output looks like this:

[ R N S R R I I KR NI - RIS N IS RN INIER |
~
Order Packing List Eﬂt
PLEASE OPEH AND INSPECT IMVEDIATELY Mountain Bikes
Page Mo

1
ooz 22 ]

ShipFromt yireme Mountain Bik es,Inc. Shipto:  BelgiumBike Co.
2001 Meridian Way Auguste D emaeghtiaan 9823
Vancouver,BC B russels, Brussels
Canada B elgium
V6G 3G6 471899

P.0. Humber: 2952

SalesPerson: JanetLeverling
Shipped Via: Loomis

D escrintion HemHo. Unit Otv Ordered | Otv Shipped
Rapel 16ireh forest green 202161 =) 2 2
Descert 22inch /steel satin 01221 En 2 z

Open Report and Add Fields

1. Open the Order Packing List.rpt report in the Crystal Reports Designer.
2. Add Orders.Order ID and Customer.Postal Code to the report canvas from the Field
Explorer.

3 Database Fields -
I I R T I I I RITI NI IN S
T Gy g IR s o+ ol = & customer

& == Customer ID

== Customer Credi
B2 Cuskomer Mame

m trem e &= Contact First M
&= Contact Last Ne

PLEASE OPEN AND INSPEC T IMMEDIATELY Mountain Bikes == Contact Title

Order Packing List

== Contact Positior
== Last Year's Sals
= Addressl

= Addressz

= City

== Region

= Country

= Postal Codz
= Er

= WebWie

== Phone

/= Fax

& & Employee
Orders
0 10
47808 == Order Amount
E ’ == Customer 1D

&= Employes ID
== Order Date
P.0O. Number: 2952 = Required Date
== Ship Date
Sales Person:  Janet Leverling == Courier Website
Shinned Vix 1 acmis == Ship Yia

Page No. 1
.
Order No.. 2952 § 2954

Ship From: xtreme Mountain B ikes, Inc. Ship to:  Belgium Bi .
2001 Meridian Way Auguste D emmaeg
Vanceuver, BC Brussels, Brussels
Canada Belgium
V6G 3G6 47899
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Turn the New Fields to Barcodes

1. Right click on Customer.Postal Code on the report canvas and select Turn to Barcode
(see the screenshot below).

T 1 — TR == = (=) e ] ‘
m®Di%E | QF A FBREIT K> M|
Barcodes X] Field: Customer, Postal Code
T
= Find in Field Explorer
B e e e e Find in Formulas
4
g g ,@ Change Format. ..
Order Packing List EE - B et pairer
i ] | Turn To Barcode, ..
PLEASE OPEN AND INSPECT IMMEDIATELY
i Highlighting Expert...
Page Ho.: 4
Dy SR R B3 Browse Field Data...
Q Select Expert...
Insert 3
Move »
Ship From:  yreme Mountain Bikes, Inc. Shipto:  Belgium Fecondhodton’
2001 Meridian Way Auguste %
Vancouver, BC Brussels
Canada Belgium Copy
V66 366 47899 Delete
_ Copy Smark Tag
wrang

2. Choose Code 39 Full ASCII from the dialog that appears.
3. Repeat steps 1 and 2 for Orders.Order ID.

NOTE: If your barcode shows as ##### you need to make the field wider.
Other Ideas

e (Create barcodes based on formula fields.

e Use different barcode fonts.

* Try string fields, date/time fields, number fields.

* Export the report to PDF.

Order Packing List Completed.rpt reflects what the finished report will look like.

4.6 XML Exporting

In this exercise you're a law enforcement employee. You want to submit a list of offences to an
external party using a common interchange data format: Justice XML Data Model (JXDM).

To create JXDM-compliant XML, you add an XML transformation to your report to convert from
Crystal Reports new data-oriented XML to JXDM.
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Add a New XML Export Format to the Report
Open jxdml.xsl and save it to disk. Open the report offenses.rpt in Crystal Reports.
1. In the Crystal Reports Designer, select Manage XML Exporting Formats... from the

File> Export menu. You should see the Manage XML Exporting Formats window, as
below.

#ML Exporting Formats: Show Schema. ..

Crystal Reports XML {default)

Set iewer Default

Description
Oukput ¥ML according ta the builk-in schema

l Ok H Cancel ][ Help

2. Pressthe Add... button to add the JXDM format.
3. Enter the information as shown below. Press the Select XML Transform... and select the
jxdm.xsl file.

Add a New XML Format

Mame: Justice Data Submission

Export Options
[Ninclude images and hinary data fields (ELOBS)

apply =ML Transform
Choose an XML transForm (%SLT) ko stare in the report and apply o the exported SpL:

See ¥ML Transform samples on the Crystal Reports Web Site

Import %ML Transform, ..

Specify the file type of the output file Format: AML

The description of this export format:

Justice data Format|

[ Ok l[ Cancel ]

4. Press OK on the Manage XML Exporting Formats window to close it.
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Export Report to XML Formats

1. Select File> Export-> Export Report to export the report to the generic XML format.
2. Select XML in the export dialog. Change the Destination to Application, then press OK.

Farmat:

= v

Destination:

= Application “
Descripkion

Application deskination exports the repart ko a temporary file in the
specified format and then opens the file in the appropriate application.

The XML Export Options dialog box (below) will appear so you can choose the format of the
output to produce

Please choose an ML exporting Format:

Crystal Reports xML (default)
Justice Data Submission

Descripkion
Justice data Format

[ K, l[ Canicel ]

3. Select the Crystal Reports Generic Data-Oriented XML format. The report will be
exported to XML launched in Internet Explorer.

4. Follow the same exporting procedure, but this time in the XML Export Options dialog,
select Justice Data Submission. The output will appear as:

Crystal Reports 2008—Reviewers Guide Page 24 of 26



&]C:\Documents and Settings\jingram\Local Settings\Temp\~of2C4. XML - Microsoft Internet Explorer g@
File  Edit  ‘iew Favorites Tools  Help : Links ﬁj Google ‘ahoo! Mail @Hotmail @'] Dictionary = :'
W bact > \ﬂ \ELI _;\J j.\"Search ‘:'/'1:/ Faworites Q?T = ‘_-::_; ] - _|

Address |L Ci\Documents and SettingsiLocal Settings! Templ~of 2C4, XML| [\:j [eh] & Snaglt E &

Tl
<txml version="1.0" encoding="UTF-8" 7=
- <CrystalReport #mins="urn:crystal-reports:schemas:report-detail" [
wmins:wsi="http:/ /www.w3.org/ 2000/ 10/ XMLSchema-instance"> L
- =<Group Level="1"> |
- <GroupHeaders
- «Section SectionMumber="0"» i
- «Field Mame="OffenseType" Ficldiame="GroupMName {({@IncidentName})">
<Formattedyalue=Drug Offenses</Formattedvalues
<Yalue=Drug Offenses </ alue>
=/Field=
</Section:
</GroupHeader>
- <Details Level="2"=
- <Section SectionMumber="0">
- <Text Mame="Text9">
zTextValue=SurName:</TextValues
=/ Terts=
- <Text Mame="Text8">
zTextValue=Given Name:</TextValue:
=/ Terts=
- «<Field Name="GivenName1l" FieldMame="{Person.GivenName}">
<zFormattedvalue=Zameer</Formattedyvalues
<Yalue=Zameer</alue=
</Field=
- <Field Hame="SurMamel" FieldMame="{Person.Surhame}">
<Formattedyvalue=Andani=/Formattedyalue:
<MaluerAndani</Valug=
=/Field= -
~fSertinn= lv]
ﬁj Done j Iy Computer

Other Ideas

* Inspect the jxdm.xsl file to learn more about producing text files with XSLT.
® Learn more about XML at http://www.w3.org/XML/ .

e Learn more about XSL Transformations at http:// www.w3.org/TR/xslt.

4.7 Web Service Data

In this example, your IT infrastructure contains valuable data that is stored on a mainframe
which includes information produced by business logic. Your task is to produce reports using
this information. The challenge is that there is no standard data connectivity that can access the
information generated from the business logic. Crystal Reports 2008 allows you to produce the
XML-format text files containing the information you need.

Create a Report on XML with HTTP
This exercise requires a web server with a virtual directory.

1. Place customer.xml and customer.xsd in the virtual directory (files are included in
Reviewers Guide Files.zip).
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2. Testif you can access the data by entering the URL to the customer.xml file in your
browser. XML data files can be produced by database applications like Microsoft Access.

Other Ideas

* Try the web service report, amazonwebservice with CR books.rpt (included with the
Reviewers Guide reports), which returns book and DVD queries from the Amazon web
service.

e Try setting up IIS on Windows and create a virtual directory. Find a data set like
xtreme.mdb and use Microsoft Access to export a few tables to XML files. Place them in
the virtual directory.

e Try connecting to an external web service that offers data. www.xignite.com has a
number of interesting financial-oriented web services as well as trial accounts. Crystal
Reports has been tested with these services.

e Try reporting directly off of XML files.

e Advanced: Try reporting off of a web service secured with WS-Security. This requires
setting up a WS-Security configuration file. The XML driver uses the Apache Axis 2 Web
Services stack.
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